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1. Bottom mounted cylinder

This tutorial shows how to create the CAD/CAE model 
corresponding to the validation case Bottom mounted cylinder 
of SeaFEM that analyzes the diffraction problem of a bottom 
mounted cylinder of radius R=1m and height H=1m. The analysis 
is carried out for a monochromatic wave of amplitude A=0.1m 
and wave length λ=2m propagating in a domain of 1 meter 
depth.

Since water depth (d) is exactly one half of the wave length (λ) 
considered here, the corresponding wave period can be 
evaluated from a deep water approximation, this being 
generally valid for d/λ > 0.5. Under this assumption, wave length 
and wave period are correlated by the following expression:

λ = g · T2

2π = 1.56 · T2

The following image shows a top view of the computational 
domain. The intermediate zone centered at the origin and with 
diamater D=4m has a relatively small element size assigned so 
that a more accurate solution can be obtained within the region 
close to the body. 

It shall be usually necessary to introduce some artificial 
dissipation away from the body, specially when dealing with 
irregular sea state conditions. Such a dissipation is introduced 
in order to damp those waves refracted and radiated by the 
body and to avoid them to be reflected in the outer boundary of 
the computational domain. The region where artificial 
dissipation is introduced is called the absorption area, while the 
region close to the body where no dissipation exists is referred 
as the analysis area. It is a good practice to make the dissipation 
start sufficiently away from the body but inside of a finner mesh 
region to avoid internal wave reflections due to large elment 
sizes and large mesh size transitions. Because of this, it is 
recommended to avoid abrupt changes in the mesh element 
sizes like those arising when intermidiate auxiliary volumes with 
small element sizes assigned are combined with large values of 
the unstructured mesh size transition. Hence, in the present 
case a unique volume encompassing the entire computational 
somain is used. And the beginning of the absorption area 
(beach) is placed at a distance of 2 meters from the center of 
the scattering cylinder. This way, the free surface analysis area 
exactly coincides in this case with the finner mesh region 
centered at the origin.

The analytical solution for this analysis is taken from the work 
"R. McCamy and R. Fuchs, Wave forces on piles: a diffraction theory. 
Tech. Memo No. 69, U.S. Army Corps of Engrs, 1954". For further 
information on this validation case, please review the "Validation 
Case 1: Bottom mounted cylinder", at the following link:

http://www.compassis.com/compass/en/Soporte

To automatically load the model, ready to be meshed and run, 
simply left-click on the button below.

Load model

On the contrary, to build the model from scratch proceed as 
indicated in the following sections of this tutorial.

1.1. Geometry definition

In this section, we will describe in detail the geometry 
generation process. SeaFEM has plenty of tools for geometry 
generation. Hence, the way to construct the geometry that is 
shown in this tutorial may constitute just one of many 
possibilities. For a more detailed description of geometry 
generation tools and other pre-processing capabilities of 
SeaFEM, we strongly recommend the user to take a look at the 
GiD pre-processing manual (see 
http://www.gidhome.com/support). 

For the present case, both the body and the computational 
domain are cylindrical, and therefore they can be easily created 
by means of the geometry generation tools available in the GUI 
of SeaFEM. Before starting to construct the geometry, it is 
important to remark that the entire computational domain in 

http://www.compassis.com/downloads/Manuals/Validation/SeaFEM%20-%20Validation%20Test%201%20-%20Bottom%20Mounted%20Cylinder.pdf
http://www.compassis.com/downloads/Manuals/Validation/SeaFEM%20-%20Validation%20Test%201%20-%20Bottom%20Mounted%20Cylinder.pdf
http://www.compassis.com/downloads/Manuals/Validation/SeaFEM%20-%20Validation%20Test%201%20-%20Bottom%20Mounted%20Cylinder.pdf
http://www.compassis.com/compass/en/Soporte
http://www.compassis.com/compass/en/Soporte
http://www.gidhome.com/support
http://www.gidhome.com/support
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SeaFEM must be located below the undisturbed water surface 
(i.e z≤ 0). In the present case, the domain will be also centered 
at the origin (0,0,0).

Before starting to construct the geometry, few general 
advertisements become pertinent:

1. For the cases where no currents are imposed, the most 
indicated shape for the computational domain is a cylinder. The 
computational depth should be no larger than the physical 
depth. Moreover, computational depth might be smaller than 
physical and/or recommended depth if the bottom boundary 
condition is used.

2. A region with higher mesh resolution is usually needed close 
to the floating object in order to correctly capture the scattered 
waves solution (waves radiated and difracted by the floating 
object). In the present case, the border of this area will coincide 
with the beginning of the damping/absorption area (beach), 
although this is not mandatory in general. Actually, the 
absorption area should be at least as long as the maximum 
wave length, although the recommended length is twice the 
maximum wave length. Nevertheless, if monochromatic wave is 
used along with Sommerfeld radiation condition, the absorption 
area might be reduced to half the wave length. 

3. To further facilitate boundary conditions assignement and 
many other pre-processing operations, it is advisable to 
organize the geometry by layers. 

Now, one of the several possible ways for generating the 
geometry of the present tutorial will be explained. Simply follow 
the steps in the given order.

First we proceed to create the bottom surface of the entire 
computational domain.

1. Open the layers window and rename the existing layer to 
domain_contour.

Utilities ► Layers

- Right click on the layer named Layer0

- Select the Rename option

- Enter the name of the new layer (i.e. 
domain_contour).

2. Create the bottom boundary of the computational domain. It 
consists of a circle located at z = -1.0 m. and of radius R = 6.0 m.

Geometry ► Create ► Object ► Circle

- Enter center: 0 0 -1

- Enter normal: Positive Z

- Enter radius: 6.0

3. Create a new layer called Body.

Utilities ► Layers

- Right click on the layers window

- Select the New layer option

- Enter the name of the new layer (i.e. 
Body).

4. Create a circle representing the base of the body.

Geometry ► Create ► Object ► Circle

- Enter center: 0 0 -1

- Enter normal: Positive Z

- Enter radius: 1.0

5. Delete the surface of the bottom mounted cylinder to retain 
just the lines that define the perimeter of the body.

Geometry ► Delete ► Surfaces

- Select the surface of the bottom 
mounted cylinder

7. Generate a hole within the NURBS surface corresponding to 
the bottom boundary of the computational domain.

Geometry ► Edit ► Hole NURBS surface

- Enter surface: Select the domain bottom 
boundary suface.

- Enter lines to define the hole:Select the 
lines that define the base of the bottom 
mounted cylinder.

Up to this point, the gometry of the model should look like the 
figure below.
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Isometric view of the bottom boundary of the computational domain

8. Create the lateral boundary of the computational domain. It 
can be simply created by extrusion of the lines delimiting the 
outter bottom boundary.

Utilities ► Copy

- Entity type: Lines

- Transformation: Translation

- First point: 6.0, 0.0, -1.0

- Second point: 6.0, 0.0, 0.0

- Do extrude: Surfaces

- Select the lines that define the outter 
perimeter of the domain's bottom surface

9. Create the inner lateral boundary of the computational 
domain, which coincides with the wall of the bottom mounted 
cyliner. As in the prvious step, this can be done by copying and 
extruding the inner and outer lines of the domain's bottom 
surface.

Utilities ► Copy

- Entity type: lines

- Transformation: Translation

- First point: 6.0, 0.0, -1.0

- Second point: 6.0, 0.0, 0.0

- Do extrude: Surfaces

- Select the lines that define the 
perimeter of the cylinder's base

After this, the geometry of the computational domain should 
look similar to what is shown in the following figure.

Isometric view of the computational domain after extrusion of the domain's bottom lines, 
and before generation of the free surface

10. Create a new layer called free_surface.

Utilities ► Layers

- Right click on the layers window

- Select the New layer option

- Enter the name of the new layer (i.e. 
free_surface)

11. Create the perimeter of the analysis area.

Geometry ► Create ► Object ► Circle

- Enter center: 0 0 0

- Enter normal: Positive Z

- Enter radius: 2.0

- Delete the created surface to retain just 
the lines

12. Create the free surface analysis area.

Geometry ► Create ► NURBS Surface ► By contour

- Select the lines that define both, the 
inner and outter boundaries of the free 
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surface analysis area.

13. Create the free surface absorption area.

Geometry ► Create ► NURBS Surface ► By contour

- Select the lines that define both, the 
inner and outter boundaries of the 
absorption area.

14. Create a new layer named volumes 

Utilities ► Layers

- Right click on the layers window

- Select the New layer option

- Enter the name of the new layer (i.e. 
volumes).

15. Create a volume encompassing the entire computational 
domain

Geometry ► Create ► Volume ► By contour

- Select all the surfaces of the model.

The final geometry should look similar to what is shown in the 
next image:

Isometric view of the entire computational domain for the bottom mounted cylinder 
analysis

1.2. General data
Once the geometry is ready, it is necessary to set up the 
problem. First of all, select to perform a seakeeping analysis as 

shown in the following image caption of the SeaFEM data tree.

Environment and analysis type options highlighted within the SeaFEM data tree

Seakeeping analyses undertaken using SeaFEM always consider 
that the fluid medium is sea water. Nevertheless, water density 
can be adjusted to match the actual fluid properties variation. 
For the present analysis, water density is taken as ρ = 1025 
kg/m3.

General data ► Water density ► Water density: 1025 kg/m3

Note that even though the cylinder is fixed to the bottom and, 
therefore, no seakeeping analysis is needed to be performed in 
this case, the Seakeepingoption is activated in order to allow the 
Body condition to be assigned to the geometrical entities 
representing the cylinder.

Also note that these general simulation parameters can also be 
set from the Start Data window which prompts when the 
program is started, or when clicking the following option within 
the menu bar.

Data ► Start data

SeaFEM start data window
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1.3. Problem description

As mentioned previously, a zone where no artificial dissipation 
exists must be defined for numerical convinience. Such a none-
dissipative region is usually centered at the body under analysis, 
and its outer boundary is specified by the beach parameter that 
must be inserted in the data tree. In this particular example, the 
beach parameter is set up so that the none-dissipative region 
coincides with the region with finner mesh resolution created 
around the body. Nevertheless, such a coincidence is in general 
not mandatory.

The beach parameter and other related data must be specified 
as indicated in what follows:

Problem description

- Bathymetry: Constant 
depth

- Depth: 1.0 m

- Wave absorption: Yes

- X absortion reference: 0 m

- Y absortion reference: 0 m

- Absorption factor: 1.0

- Beach: 2.0 m
- Sommerfeld radiation 
condition: Yes

Problem description data shown within the 
SeaFEM data tree and on the corresponding 

data window.

1.4. Environment data
Next, environment data basically related to the waves spectra of 
the analysis must be specified. In the present case, the wave 
environment simply consist on a monochrometic wave whose 
properties must be specified as indicated here:

Environment data ► Waves

- Wave spectrum type: 
Monochromatic wave

- Amplitude: 0.1 m

- Period: 1.1322 s

- Direction: 0.0 deg

Wave spectra data shown within the SeaFEM 
data tree and on the corresponding data 

window.

1.5. Time data
Apart from wave environment, analysis data concerning the 
time step and total simulation time must be introduced. For the 
present simulation these data reads as follows:

Time data

- Simulation time:25 s

- Time step:0.0 s

- Output step: 0.1

- Start time recording:10 s

- Initialization time:10 s

Time data section within the SeaFEM data 
tree and on the corresponding data 

introduction window.

Time step is set to 0.0, so that it will be internally evaluated by 
SeaFEM based on a stability criteria related to the Free surface 
stability factor.

1.6. Boundary conditions

To completely define the numerical problem to be solved, some 
boundary conditions must be assigned to the geometry. In this 
section we will see a number of conditions that must be defined 
for every SeaFEM problem. Some other conditions exist within 
SeaFEM that can be used to define more specific types of 
problems. Such advanced conditions will be further presented 
in more advanced tutorials. In the present case, it will suffice to 
define free surface, outlet and body conditions as shown in the 
figure below.

Boundary conditions used in the present tutorial are shown highlighted here within the 
data tree of SeaFEM.

First, a free surface boundary condition must be applied. As the 
name indicates, such a condition must be applied to all surface 
entities of the geometry that are located at the free surface of 
the model (i.e. at z=0).
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Isometric view showing the free surface boundary condition applied to the model.

Next, an oulet boundary condition must be applied. As the name 
also indicates, the outlet condition is applied to the outmost 
boundary of the computational domain.

Isometric view showing the outlet boundary condition applied to the model

Finally, a body boundary condition must be applied to all 
surfaces defining the boundary of the body structure under 
analysis. In the present case, it simply consist on the boundary 
surface of the bottom mounted cylinder.

Body degrees of freedom data window

Body properties data window

Isometric view showing the body boundary condition applied to the wall of the bottom 
mounted cylinder
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In this basic tutorial, the body structure under analysis is 
anchored to the bottom surface of the domain so that 
seakeeping analysis is not necessary. Nevertheless, body 
boundary condition must be applied to identify the solid 
structure responsible for the reflection/diffraction of the 
incident monochromatic wave. As shown in the figures above, 
body properties such as mass and center of gravity can be all 
set to zero since they do not play any roll in the simulation of a 
completely anchored body. All degrees of freedom remain also 
deactivated.

1.7. Numerical data
Finally, several parameters are available within the SeaFEM GUI 
concerning numerical aspects of the solver. For the present 
simulation only the following parameters are relevant:

Numerical data

- Solver:Stabilized bi-conjugate 
gradient (tolerance = 1.0E-7)

- Preconditioner:ILU

- Free surface stability factor:0.5

Numerical data section of the SeaFEM data 
tree, and the corresponding data 

introduction window.

1.8. Mesh
The last step before calculation is mesh generation. Mesh 
properties for the present analysis are summarized in what 
follows.

A minimum element size of 0.1 is assigned to the boundary 
surface of the bottom mounted cylinder and to the free surface 
portion contained within the analysis area. The following main 
menu options must be used for the assignment of unstructured 
mesh sizes to surfaces and volumes respectively:

Mesh ► Unstructured ► Assign sizes on surfaces

Mesh ► Unstructured ► Assign sizes on volumes

The following pictures show the result of these mesh size 
assignments:

Mesh sizes assigned to the surface of the bottom mounted cylinder and to the free surface 
analysis area

Mesh sizes assigned to the lines that defined the boundaries of the cylinder and of the free 
surface analysis area

Once mesh element sizes are assigned, we can proceed to mesh 
generation by using the following main menu option:

Mesh ► Generate mesh

The following window pops up, where maximum element size 
and mesh transition can be specified. By using a maximum 
element size of about 0.5 and an unstructured size transition of 
0.2 a mesh is obtained consisting of 35.921 nodes and 208.107 
tetrahedra elements.

Mesh generation window showing maximum element size and unstructured size transition.
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The next picture shows an isometric view of the resulting mesh. 
It can be appreciated how the mesh is gradually refined when 
approaching the surface of the bottom mounted cylinder.

Computational domain mesh used for the bottom mounted cylinder analysis.

1.9. Results
Wave elevation results obtained using SeaFEM can be compared 
against the analytical solution. In the figure below wave 
elevation iscontours are shown in the free surface region close 
to the mounted cylinder. Solid lines correspond to the analytical 
solution given by the reference, while dashed lines correspond 
to the solution computed using SeaFEM. Note that both 
solutions are in very good agreement.

Reference versus SeaFEM solutions concerning wave elevation results.

The following figure shows the pressure distribution at the 
cylinder surface. 

Contour fill of the dynamic pressure over the body.

For visualizating pressure contours, just select the 
corresponding result in the post-process data tree:

Postprocess panel of SeaFEM

Finally, the force exherted by the incident waves over the body 
was recorded during a significant time period. The resulting 
oscillating force in the X direction (incidence direction) is 
compared herein with the corresponding analytical solution in 
the reference.

As in the case of previous verification data, the two signals are 
in good agreement in terms of booth, amplitude and oscillation 
period.
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Fx force exherted by the monochromatic wave over the bottom mounted cylinder.

In order to generate plots and graphs of the computed results, 
you can access the SeaFEM graphs window by going to the 
menu option

Postprocess ► SeaFEM graphs

and selecting the desired result:

Graph utils window within the SeaFEM postprocess.
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2. Floating cylinder

The present tutorial analyzes the seakeeping behaviour of a 
freely floating cylinder subject to the action of a monochromatic 
wave. In addition to the usual preprocessor steps necessary to 
define a SeaFEM model, in this tutorial postprocess capabilities 
will be described in detail.

The following image shows an isometric view of the 
computational domain.

Isometric view of the computational domain.

2.1. Geometry definition

In this section, we will describe in detail the geometry 
generation process. Both, the floating body and the 
computational domain analyzed in this tutorial are cylindrical 
and can be easily created using the CAD capabilities of the 
SeaFEM GUI in a similar way as that described in the previous 
tutorial Tutorial 1.

The geometry of the present model consists on a cylindrical 
body of radius R=1.0 m and draft D=0.5 m embeded within a 
cylindrical computational domain of radius R=15.0 m and depth 
H=10.0 m. For the sake of convinience, an intermidiate circular 
region at the free surface and around the floating cylinder is 
created so that the mesh size can be controlled more easilly. We 
refer to this intermidiate area as the analysis region since we 
will force this area to coincide with the region of the model 
where no wave dissipation is introduced.

The final geometry of the model will look similar to that shown 
in the following picture.

Geometry of the whole computational domain.

First, proceed to create the bottom surface of the computational 
domain.

1. Open the layers window and create a layer called Bottom:

Utilities ► Layers

- Right click on the layers window

- Select the option New layer

- Rename the layer to Bottom

2. Create a circle for the base of the computational domain:

Geometry ► Create ► Object ► Circle

- Enter center: 0.0 0.0 -10.0

- Enter normal: Positive Z

- Enter radius: 15.0

3. To facilitate the meshing process, it is sometimes a good idea 
to generate a more symmetric geometry. To this aim, simply 
divide the created circle in two segments:

Geometry ► Edit ► Divide ► Lines ► Num divisions ► 2

Next, lets create the lateral surfaces of the computational 
domain.

4. Create lateral domain surfaces by extrusion of the bottom 
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boundary surface.

Utilities ► Copy

- Entities type: surfaces

- Transformation: Translation

- First point: 0.0, 0.0, 0.0

- Second point: 0.0, 0.0, 10.0

- Duplicate entities: Off

- Do extrude: surfaces

- Select Bottom layer surfaces and 
proceed with the copy/extrusion process. 

5. Create the boundary surfaces of the floating body. To this 
aim, first create the bottom surface of the floating cylinder:

Geometry ► Create ► Object ► Circle

- Enter center: 0.0 0.0 -0.5

- Enter normal: Positive Z

- Enter radius: 1.0

6. Divide the created circle in two segments:

Geometry ► Edit ► Divide ► Lines ► Num divisions ► 2

7. Extrude the bottom circular surface of the floating cylinder up 
to the free surface

Utilities ► Copy

- Entities type = surfaces

- Transformation = Translation

- First point = 0.0, 0.0, 0.0

- Second point = 0.0, 0.0, 0.5

- Duplicate entities = Off

- Do extrude = surfaces

- Select Bottom surface of the floating 
cylinder

8. Create the free surface analysis area

Geometry ► Create ► Object ► Circle

- Enter center: 0.0 0.0 0.0

- Enter normal: Positive Z

- Enter radius: 3.0

9. Divide the created circle in two segments:

Geometry ► Edit ► Divide ► Lines ► Num divisions ► 2

10. Delete the created surface and regenerate the free surface 
analysis area containing the hole corresponding to the 
waterline of the floating cylinder.

Geometry ► Delete ► Surfaces

- Select the inner free surface and 
proceed to delete.

Geometry ► Create ► NURBS surface ► By contour

- Select the edges of both, the perimeter 
of the floating cylinder and the boundary 
of the analysis region.

- Proceed to create the analysis area free 
surface. 

11. Create the outer free surface.

Geometry ► Create ► NURBS surface ► By contour

- Select the edges of both, the perimeter 
of the analysis region and the outer 
perimeter of the computational domain.

- Proceed to create the outer free surface. 

12. Finally, we must simply generate a volume encompasing the 
entire computational domain.
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Geometry ► Create ► Volume ► By contour

- Select all the surfaces in the model.

- Proceed to create the computational 
domain volume.

13. Organize geometry by layers.

Utilities ► Layers

- Right click on the layers window

- Select the option New layer

- Rename the layer to Auxiliar

- Repeate the process to create Body, 
Free_surface, Outlet and Volumes layers.

- Move geometrical entities to their 
corresponding layers to further facilitate 
boundary conditions assignement.

The final appearance of the generated computational domain is 
shown in the following figure. 

2.2. General data
Once the geometry is ready, it is necessary to set up the 
problem. First of all, select to perform a seakeeping analysis. 
For this, open the Start Data window and select the following 
options:

Data ► Start data

- Simulation dimension = 3D

- Seakeeping analysis environment = 
Waves

- Seakeeping analysis type = Seakeeping

Seakeeping analyses undertaken using SeaFEM always consider 
that the fluid medium is sea water. Nevertheless, water density 
can be adjusted to match the actual fluid properties variation. 
For the present analysis, water density is taken as ρ = 1025 
kg/m3.

General data ► Water density ► Water density: 1025 kg/m3

2.3. Problem description

A zone where no artificial dissipation is introduced must be 
defined for numerical convinience. Such a none-dissipative 
region is usually centered at the body under analysis, and its 
outer boundary is specified by the beach parameter that must 
be inserted in the data tree. In this particular example, the 
beach parameter is set up so that the none-dissipative region 
coincides with the region with finner mesh resolution created 
around the body. Nevertheless, such a coincidence is in general 
not mandatory.

Open the Problem description container in the SeaFEM data tree 
and fill in the corresponding data as follows:

Problem description

- Bathymetry: Constant depth

- Depth: 10.0 m

- Wave absorption: Yes

- X absortion reference: 0 m

- Y absortion reference: 0 m

- Absorption factor: 1.0

- Beach: 3.0 m

- Sommerfeld radiation condition: Yes

2.4. Environment data
Next, environment data basically related to the waves spectra of 
the analysis must be specified. In the present case, the wave 
environment simply consist on a monochromatic wave whose 
properties must be specified as indicated here:

Environment data ► Waves

- Wave spectrum type: Monochromatic 
wave
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- Amplitude: 0.1 m

- Period: 2.0 s

- Direction: 0.0 deg

2.5. Time data
Apart from wave environment, analysis data concerning the 
time step and total simulation time must be introduced. For the 
present simulation these data reads as follows:

Time data

- Simulation time:25 s

- Time step:0.0 s

- Output step: 0.25

- Start time recording:10 s

- Initialization time:10 s

When time step is set to 0.0, it is actually evaluated internally by 
SeaFEM based on a stability criteria related to the Free surface 
stability factor entered in the Numerical data section of the data 
tree.

2.6. Boundary conditions

In this case, there exist three boundary conditions to be 
applied. They are similar to those used in Tutorial 1. 

First, a Body condition must be applied to the boundary 
surfaces of the floating cylinder (surfaces in cyan in the picture 
bellow). Body properties should read as follows:

Body data ► group:name ► Body properties

- Mass: vol*density

- XG:0.0 m

- YG:0.0 m

- ZG:0.0 m

- Radii of gyration: 1.0 m

Body data ► group:name ► Degrees of freedom

- Surge: Yes

- Sway: Yes

- Heave: Yes

- Roll: Yes

- Pitch: Yes

- Yaw: Yes

Next, a Free surface condition must be applied to those surfaces 
located at z=0 (dark blue and brown surfaces in the picture 
bellow).

Boundary conditions ► Free surface

Finally, an Outlet boundary condition must be applied to the 
outer boundary of the computational domain (surface in 
magenta in the picture bellow). If a Sommerfeld radiation 
condition is to be applied, the outer surface should be of 
circular shape with center at the origin of coordinates.

Boundary conditions ► Outlet

Boundary conditions used in the floating cylinder analysis.

2.7. Numerical data
For the present simulation only the following numerical 
parameters are relevant:

Numerical data

- Solver: Conjugate gradient (tolerance = 
1.0E-7)

- Preconditioner: ILU

- Solver tolerance: 1.0E-7

- Solver max. iterations: 1000

- Free surface stability factor: 1.0
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2.8. Mesh
The last step before calculation is mesh generation. Mesh 
properties for the present analysis are summarized in what 
follows.

1. A minimum element size of 0.1 is assigned to the surfaces, 
lines and points of the bottom mounted cylinder. 

2. An element size of 0.2 is assigned to the free surface region 
contained within the analysis area and to its outer perimeter. 

3. An element size of 1.0 is assigned to the entire bottom 
surface of the computational domain.

4. Finally, an element size of 1.5 is assigned to the outer part of 
the free surface (out of the analysis area) and to the outlet 
boundary.

The following picture shows the result of these mesh size 
assignments:

Mesh sizes assigned to the different regions of the computational domain.

Once mesh element sizes are assigned, we can proceed to mesh 
generation by using the following main menu option:

Mesh ► Generate mesh

The following window pops up, where maximum element size 
and mesh transition can be specified. By using a maximum 
element size of about 1.5 and an unstructured size transition of 
0.1 a mesh is obtained consisting of about 30.000 nodes and 
175.000 tetrahedra elements. The final resulting mesh is shown 
in the figure bellow.

Computational domain mesh used for the floating cylinder analysis.

2.9. Results
In this section the post-processing capabilities of SeaFEM will be 
described in some detail. The following topics will be addressed:

1. Visualization of wave elevation results. 

2. Visualization of the pressure fields over the wetted surface of 
the floating structure.

3. We will also learn how to set-up an animation of the body's 
motion.

4. Graphics utils window will be used to readily visualize the time 
evolution of body movements and forces.

Once the calculation has finished, we can access the SeaFEM 
post-process module by using the following option in the main 
menu:

Postprocess ► Start

The main post-processing options of SeaFEM are readily 
available at one touch through the post-process panel located 
at the left hand side of the post-processing main window. Such 
a panel has 4 main areas. These are, from top to bottom:

1. The Animations panel mainly used to control the animation 
flow.

2. The Meshes panel that can be used to activate/deactivate 
various visualization options of separate meshes.

3. The Results panel that is used to select the results for to be 
visualized.

4. The Preferences panel used to control basic as well as 
advanced visualization options.

Results visualiztion by Contour fill options.

In the two following figures, the contour fills corresponding to 
the total and scattered wave elevation results are shown 
respectively. The desired result is simply selected on the Results 
section of the post-process panel. The top view used in the 
present figures can be set by using the main menu option

View ► Rotate ► Plane XY (original)
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Total wave elevation (incident + scattered) results at time step t = 49.3 s.

Scattered wave elevation results.

Pressure field contour fills over the surface of the floating body 
can be visualized as well by selecting the corresponding result 
type within the Results panel.

Pressure (induced + hidrostatic) results over the body surface

 Set up of a body movements animation.

An animation of the body can be setup within the 
postprocessor. To this aim, the following option of the menu 
can be used. 

Postprocess ► Computer animations

By using this option, a set of animation templates becomes 
available. Various default animation template files in XML 

format (*.xml) can be found within the animations folder of the 
SeaFEM installation directory. These default templates are 
provided to be used to create new animations automatically. 
New template files can be added into the "animations" folder to 
perform special animations that fulfill the user particular 
demands. A detailed description of the XML sintax to be used in 
animation template files can be found in the "CompassLIB 
Postprocess" manual in http://www.compassis.com/downloads/
Manuals/CompassLIBPostprocessReference.pdf.

In our particular case, the default "Seakeeping animation" 
template file can be used in order to setup an animation of the 
floating cylinder. By selecting the menu option 

Postprocess ► Computer animations ► Seakeeping 
animation

the following window will pop-up. The animation window may 
be filled by simply providing the 
*.BodyMovements_animations.res" file, and an auxiliary body 
mesh file (named here Body.msh) that must be previously 
created and exported using GiD mesh format in the SeaFEM 
preprocessor. Such an auxiliary mesh must exclusively contain 
the surface mesh of the body under consideration. It might be 
noted however, that such a body surface mesh may contain 
both the wetted and the dry parts of the floating structure.

After completion of the animations window information, the 
new body mesh will be loaded and added to the postprocessor 
meshes panel. Once this is done, an animation can be started so 
that the body mesh will be animated following the movement 
results contained in the *.BodyMovements_animations.res" file.

In the following set of figures, the animated position of the 
floating cylinder is shown for four different time steps. In these 
figures, the free surface is rendered transparent to allow 
visualization of the body mesh during the animation.

http://www.compassis.com/downloads/Manuals/CompassLIBPostprocessReference.pdf
http://www.compassis.com/downloads/Manuals/CompassLIBPostprocessReference.pdf
http://www.compassis.com/downloads/Manuals/CompassLIBPostprocessReference.pdf
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 Graph tools window

Body movements and loads can be also visualized by using the 
SeaFEM graphs utility. It can be accessed through the 
"Postprocess" menu, once the results have been loaded into the 
postprocessor. 

Postprocess ► SeaFEM graphs

The SeaFEM graph utility looks like the figure below. Within the 
Results type combobox, the user can select which type of results 
wants to analyze (i.e. bofy movements, body forces, user 
defined results, etc.). Once the results type is selected, the 
available results are loaded in the bottom part of the graphs 
window, so that individual results can be selected separately for 
visualization.

In the particular case of the present application example, Surge, 
Heave and Pitch body movements result in the following time 
evolution graphs.

Time evolution of the Surge body movement

Time evolution of the Heave body movement



Compass - http://www.compassis.com
17

SeaFEM tutorials manual

Time evolution of the Pitch body movement

Total forces and moments acting on the body can also be 
visualized by using the same SeaFEM graphs utility.

Time evolution of the Fx body force

Time evolution of the Fz body force

Time evolution of the My moment

3. GVA 4000 Semisubmersible structure
In this Tutorial, a SeaFEM model is created in order to analyze 
and validate the RAO behaviour of a free-floating semi-
submerged structure, while pulled by an external force. The 
following image shows the computational domain and a detail 
of the submerged part of the floating structure:

In order to perform the RAO analysis, a monochromatic wave 
spectrum is used. And the external force is represented using 
an elastic constrain.

The RAOs calculated in this tutorial are compared with the 
experimental results published in the work from “Clauss G.F., 
Schmittner C. and Stutz K., Time-domain investigation of a 
semisubmergible in rogue waves. Proceedings of OMAE'02, 21st 
International Conference on Offshore Mechanics and Arctic 
Engineering. June 2002.” 

To automatically load the model, ready to be meshed and run, 
simply left-click on the button below.

Load model

On the contrary, to build the model from scratch proceed as 
indicated in the following sections of this tutorial.

3.1. Geometry definition and body data

In this tutorial, geometry creation is not described in detail. 
Although the geometry of the floating structure is simple 
enough as to be constructed using the CAD capabilities 
provided by the SeaFEM pre-processor, we will assume that the 
geometry was already created. Actually, the geometry of the 
present model can be downloaded from the Compass website.

The geometry of the submerged part of the GVA 4000 structure, 
and the corresponding computational domain are shown in the 
figure below.
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(a) Submerged part of the GVA 4000 semisubmersible structure. (b) Computational domain.

The body has a characteristic length of 70 m and its height is 20 
m. The centre of gravity is placed at the coordinates (0,0,0.85) 
and the radii of inertia is rx=ry=rz=31.06 m. The mass of the body 
is calculated internally to equal the mass of the water displaced 
by the structure. This is achieved defining the mass of the body 
as the product of water density and displacement volume. Such 
a function must be specified within the body properties. 
Summarizing, body properties for the submersible structure 
read as follows:

Body data ► group: name ► body properties

- Mass: vol*density

- XG: 0.0 m

- YG: 0.0 m

- ZG: 0.85 m

- Hidrostatics Type: Linear

- Radii of gyration: 31.06 m

Next, degrees of freedom are activated as follows:

Body data ► group: name ► degrees of freedom

- Surge: activated

- Sway: restricted

- Heave: activated

- Roll: restricted

- Pitch: activated

- Yaw: restricted

For the computational volume, the free-surface is placed as 
always at z=0. The water depth is set to H=120 m and the domain 
has a radius of 1000 m. The beach boundary is placed 70 m away 
of the center of the body in order to avoid interferences with 
the results.

The Body data section of the SeaFEM data tree also provides the 
option to apply external forces and moments to a given body. In 
the present tutorial, we use this option to apply an elastic 
constraint to the floating structure so that it does not move 
away from its initial position. Specifically, an external force is 
applied to the body in a way that the magnitude of the force 
depends on the displacements of certain given points. 

Body data ► group: name ► External loads ► External force 
X:

-0.5E5*dx[-40.28,27.36,-17.55]-0.5E5*dx[-
40.28,-27.36,-17.55] N

Body data ► group: name ► External loads ► External 
moment Y:

0.5E5*(ZG+16.7)*dx[-40.28,27.36,-17.55]+
0.5E5*(ZG+16.7)*dx[-40.28,-27.36,-17.55] 
N·m

As can be appreciated, the force is applied in the X direction 
(movements in the Y direction are not allowed since sway 
degree of freedom was restricted), and made dependent on the 
displacement of the points located at coordinates (-40.28, 27.36,-
17.55) and (-40.28, -27.36,-17.55) respectively. An elastic 
constraint of 0.5x 105 is used. The sum of these two forces is 
equivalent to the action of an spring with an elastic modulus of 
105 N/m. The given points are the outer edges of the submerged 
structure. For consistency, a moment along the Y direction is 
also added in order to counteract the moment produced by the 
elastic force (and to ensure that the applied forces do not 
generate vertical displacements).
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3.2. General data
In the present tutorial, we are interested on the RAO behavior 
of a real structure. Hence, the seakeeping analysis of the 
structure subjected to the action of a white noise spectrum and 
without currents must be undertaken. To this aim, the general 
data of the problem must read as follows. Parameters not 
mentioned here may keep its default value.

General data ► Water density

- Water density: 1025 kg/m3

General data ► Problem setup ► Environment

- Waves: 1

- Current: 0

General data ► Problem setup ► Type of analysis

- Seakeeping: 1

- Turning circle: 0

- Towing: 0

General data ► Results ► Kinematics

- Movements: Yes

- Velocities: No

- Accelerations: No

- Raos: Yes

3.3. Problem description

As usual, a zone where no artificial dissipation is introduced 
must be created. The outer boundary of this region of no-
dissipation is specified by the beach parameter that must be 
inserted in the data tree. Away from the beach wave absorption 
is induced numerically in order to stabilize the numerical 
results.

Hence, Beach parameter and other related data must be 

inserted as indicated here:

Problem description

- Bathymetry: Constant depth

- Depth: 120.0 m

- Wave absorption: Yes

- X absortion reference: 0 m

- Y absortion reference: 0 m

- Absorption factor: 1.0

- Beach: 70.0 m

- Sommerfeld radiation condition: Yes

3.4. Environment data
Next, environment data to define the wave spectra of the 
analysis must be specified. Since in this tutorial we are 
interested in the RAOs results, a white noise spectrum must be 
used. The corresponding data is summarized bellow:

Environment data ► Waves

- Wave spectrum type: White noise

- Amplitude: 1.0 m

- Direction: 0.0 deg

- Shortest period: 8 s

- Longest period: 28 s

- Number of wave periods: 11

3.5. Time data
Apart from wave environment, analysis data concerning the 
time step and total simulation time must be introduced. For the 
present simulation these data reads as follows:

Time data

- Simulation time:600 s
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- Time step:0.3 s

- Output step: 5 s

- Start time recording:300 s

- Initialization time:200 s

Since the computational method used within SeaFEM solves the 
problem in the time domain, initial conditions are important. 
Hence, in order to attain faster the harmonic steady state, it can 
be usefull to introduce the incident potential smoothly. This is 
done by means of a cosine function that modulates the nominal 
incident potential during the initialization time. Moreover, the 
body is supposed to be initially at the equilibrium position with 
zero velocity. During the initialization period a dissipation term 
proportional to the body velocity is introduced. This dissipation 
term is smoothly decreased down to zero so that it disappears 
after the initialization period.

Keep in mind, that Time data introduced by the user in problems 
concerning RAOs analysis are just for the sake of guidance. 
Actually, SeaFEM internally evaluates optimal values for both, 
the Simulation time and the time step based on Fourier analysis 
requirements. Hence, at the beginning of the calculation, a 
message similar to that shown bellowe will be prompted into 
the information file.

 --> Time step has been switched to dt = 0.21875 s to fulfill 
Fourier analysis requirement

 --> Simulation time has been modified to 412 s to fulfill Fourier 
analysis requirement

3.6. Boundary conditions

Apart from Body data condition which is assigned to the entire 
boundary surface of the floating structure as shown in section 
Geometry definition and body data, three boundary conditions 
must be specified to set up a well-defined problem for RAOs 
analysis of the GVA 4000 structure. These are the Free surface, 
the Outlet and the Bottom boundary conditions. All of them are 
shown in the given order in the following images:

Boundary conditions ► Free surface

The Free surface boundary condition must be applied to the 
entire surface of the computational domain located at the plane 
z=0.

Free surface boundary condition

Boundary conditions ► Outlet

As usual, the Outlet condition is applied to the outter boundary 
of the computational domain.

Outlet boundary condition

Boundary conditions ► Bottom

Finally the Bottom condition, as the name indicates, is applied to 
the bottom surface of the computational domain.
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Bottom boundary condition

3.7. Numerical data
For the present simulation only the following numerical 
parameters are relevant. Parameters not refered here may keep 
their default values.

Numerical data

- Solver: Deflated conjugate gradient

- Preconditioner:ILU

- Solver tolerance: 1.0E-7

- Solver max. iterations: 1000

- Free surface stability factor:1.0

3.8. Mesh
The last step before calculation is mesh generation. Mesh 
properties for the present analysis are summarized in what 
follows.

1. A minimum element size of 1 m. is assigned to the surfaces, 
lines and points of the semisubmersible structure.

Elements size assigned to the body's surface

2. An element size of 4 m. is assigned to the free surface region 

close to the floating structure.

3. An element size of 7 m. is assigned to the surfaces of the 
intermidiate region that encloses the floating structure.

4. A larger element size about 20 m. is assigned to the surfaces 
of the cylindrical region located below the floating structure up 
to the bottom of the computational domain.

Elemet sizes assigned to the region close to the body in order to achieve better control on 
mesh size transition.

No other mesh parameters are assigned to the remaining part 
of the computational domain since the largest element size that 
will be allowed during the meshing process is also 20 m.

Once mesh element sizes are correctly assigned, we can 
proceed to mesh generation by using the following main menu 
option with the corresponding maximum size and mesh 
transition:

Mesh ► Generate mesh

Maximum element size: 20

Unstructured size transition: 0.3

The resulting mesh contains about 152.000 nodes and 870.000 
tetrahedra elements. The final resulting mesh is shown in the 
figure bellow.
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Computational domain mesh. Details of the mesh at the surface of the body and at the free 
surface close to the body.

3.9. Results
The objective of this computation using white noise spectrum, is 
to be able to obtain the corresponding RAOs (Response 
Amplitude Operators).

For doing so, the calculation is launched using the Start 
Calculation icon, or the main menu option:

Calculate ► Calculate

During the simulation, it is possible to obtain information of the 
process evolution either by clicking in the Calculation 
Information icon, or by accessing the main menu option:

Calculate ► View process info

Once the calculation has finished, we can access the SeaFEM 
post-process module by using the following option in the main 
menu:

Postprocess ► Start

Once the post-process module is loaded, it is possible to 
visualize as usual the various field results (i.e. velocity, pressure 
over body, wave elevation ...) by selecting the corresponding 
results on the left hand side panel. Nevertheless, for the present 
case RAOs results constitute the most significative output of the 
calculation. RAOs may be plotted by using the SeaFEM graphs 
util.

Postprocess ► SeaFEM graphs

Furthermore, you can also access RAOs results in text file format 
by opening the following file in the current project directory.

$(projectname)\$(projectname).Raos.res

The following images show the results obtained, compared to 
the ones obtained from the literature.

RAO Heave results

RAO Pitch results

4. TLP Tutorial
The main purpose of this tutorial is to test a real TLP platform 
corresponding to a 5 MW wind turbine using SeaFEM. Actually, 
the characteristics of the TLP used herein correspond to that 
used by the NREL (National Renewable Energy Laboratory), and 
the final goal is to compare the results obtained using SeaFEM 
against those reported by NREL. For more details, see reference 
[1]. 

The actual TLP structure under analysis has three major 
components: the wind turbine, the floating platform and the 
mooring system. In the present analysis, only the floating 
platform is physically modeled, while the mooring system and 
wind turbine effects are taken into account by using appropiate 
mass, damping and stiffness matrices. The wave environment 
used within the present analysis consists on a white noise 
spectrum. It allows to obtain response amplitude operator 
(RAO) results at different frequencies. The range under 
consideration is betwen 2,09 rad/s and 0,31 rad/s. Hence, the 
shortest period is about 3 s. and the largest one is about 20 s.

To automatically load the model, ready to be meshed and run, 
simply left-click on the button below.

Load model

On the contrary, to build the model from scratch proceed as 
indicated in the following sections of this tutorial.

4.1. Geometry definition

This section is devoted to the description of the geometry 
generation process. SeaFEM has plenty of tools for geometry 
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generation. Hence, the way to construct the geometry that is 
shown in this tutorial may constitute just one of many 
possibilities. For a more detailed description of geometry 
generation tools and other pre-processing capabilities of 
SeaFEM, we strongly recommend the user to take a look at the 
GiD pre-processing manual (see 
http://www.gidhome.com/support). 

For the present case, both the body and the computational 
domain are cylindrical, and therefore they can be easily created 
by means of the geometry generation tools available in the GUI 
of SeaFEM. Before starting to construct the geometry, it is 
important to remark that the entire computational domain in 
SeaFEM must be located below the undisturbed water surface 
(i.e z≤ 0). In the present case, the domain will be also centered 
at the origin (0,0,0).

In order to construct the geometry for the present analysis, 
simply follow the steps described below.

1. Open the layers window and create a layer called Body:

Utilities ► Layers

- Right click on the layers windoiw

- Select the option New layer

- Rename the layer to Body

2. Repeat step 1 up to five times to created new layers named 
Bottom, Free surface, Others, Outlet, Volumes.

3. Create child layers as to mimic the layers structure shown in 
the picture.

Layers structure

4. Start to create the geometry of the floating platform.

Geometry ► Create ► Object ► Circle

- Enter center: 0.0 0.0 0.0

- Enter normal: Positive Z

- Enter radius: 9.0

Floating platform circle created.

5. Create the cylindrical surface of the floating platform by 
copying and extruding the base circle.

Utilities ► Copy

- Entity type: surfaces

- Transformation: translation

- First point: 0.0 0.0 0.0

- Second point: 0.0 0.0 -47.89

- Do extrude: Surfaces

- Select the circle surface and proceed.

http://www.gidhome.com/support
http://www.gidhome.com/support
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Floating platform cylinder.

6. Clean and organize the geometry of the floating structure.

Geometry ► Delete ► Surfaces

- Select the top surface of the cylinder 
and proceed to delete.

- Activate the layer named Body

- Send all surfaces of the body to the 
correspoinding layer

Send to ► Surfaces

- Select the surfaces of the cylinder and 
proceed.

Cylinder resembling the floating platform under analysis.

Next, simply proceed to generate the computational domain. It 
represents the significative region of the sea surrounding the 
body structure under analysis (i.e. the TLP structure). Such a 
region is actually composed by two distinct areas; the first one is 
the area close to the model and is named analysis area while 
the second one is the region located far from the structure 
which is called waves absortion area or beach area. To construct 
the computational domain, follow the steps described below:

7. Create a circle delimiting the analysis area.

Geometry ► Create ► Object ► Circle

- Enter center: 0.0 0.0 0.0

- Enter normal: Positive Z

- Enter radius: 50 m

Analysis zone circle created.
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8. Clean the geometry.

Geometry ► Delete ► Surfaces

- Select the surface of the recently 
created analysis area.

9. Regenerate the free surface region of the analysis area 
encompassing the hole corresponding to the floating platform's 
undisturbed waterline.

Geometry ► Create ► NURBS surface ► By countour

-Select the top circles of both, the 
platform and the analisis region and 
proceed with the NURBS generation 
process.

10. Create a circle delimiting the absorption area.

Geometry ► Create ► Object ► Circle

- Enter center: 0.0 0.0 0.0

- Enter normal: Positive Z

- Enter radius: 600 m

11. Create the outter boundary of the computational domain.

Utilities ► Copy

- Entity type: surfaces

- Transformation: translation

- First point: 0.0 0.0 0.0

- Second point: 0.0 0.0 -200.0

- Do extrude: Surfaces

- Select the outter circle of the 
computational domain and proceed.

12. Clean the geometry.

Geometry ► Delete ► Surfaces

- Select the top surface of the 
computational domain and proceed.

13. Regenerate the free surface of the absorption area 
encompassing the hole corresponding to the analysis area.

Geometry ► Create ► NURBS surface ► By contour

- Select the top circles of the analysis 
zone and the waves absortion area.

Surface created betwen two circles, the analysis zone and the wave absortion area.

14. Organize geometry by layers.

- For each surface, activate the 
corresponding destination layer

Send to ► Surfaces

-Select the corresponding surface and 
proceed to send it to the corresponding 
layer (deactivate the option Also lower 
entities if you want to move the surface 
but not its associated lines and points).

15. Next, we must create the volume necessary to complete the 
control volume of the simulation.

Geometry ► Create ► Volume ► By countour

- Select the all surfaces of the model and 
proceed to create the control volume.

16. Send the volume to the corresponding layer.

- Select the "Inner volume" layer.
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- Deselect the option "Also lower entities".

- Use the option 

Send to ► Volumes

- Select the inner volume and proceed.

- Repeat the process with the Outer 
volume.

4.2. Body data

Once the geometry has been created, a Body data condition can 
be applied to the floating body structure to define its 
properties. To this aim, select the option 

Body data

in the data tree and assign the corresponding condition to the 
surfaces that define the floating TLP platform.

Next, fill in the Body data of the recently assigned body 
condition as indicated bellow.

Body data ► group: name ► body properties

- Mass: 0.0

- XG: 0.0 m

- YG: 0.0 m

- ZG: 0.0 m

- Hidrostatics Type: Linear

- Radii of gyration R11: 8.3 m

- Radii of gyration R22: 8.3 m

- Radii of gyration R33: 7.2 m

The mass and gravity center values used in this case need a 
more detailed explanation. As it is seen, all these values are set 
to zero in the SeaFEM data tree. This is so, because the true 
values of these parameters are actually specified using the Tcl 
extension of SeaFEM. Such a procedure may seem complicated 
at first sight, but it is done in this way to faciliate comparison 
against NREL results. This procedure has also other advantages 
for this particular case as it is explained next.

The first thing that must be noted here is that, by default all 
properties and results in SeaFEM are referred to the gravity 
center of the body under analysis. Nevertheless, this is not 

always the most convinient since many properties of the 
structure may be referred to a different point. This is the 
present case for instance, where all properties are referred in 
NREL to the origin of coordinates (0.0, 0.0, 0.0). Hence, SeaFEM 
provides the opportunity to define the properties of the 
structure (mass, stiffness and damping) using a generic 
reference point. To this aim, some functions are provided 
through the Tcl extension of SeaFEM that permit to intriduce 
mass, stifness and damping matrices of various structural 
elements (as explained in detail in the user manual [2]) being 
those actually modelled or not in SeaFEM. In the present case, 
in addition to the TLP platform mass matrix, wind turbine and 
mooring system contributions will be added using the Tcl 
extension mentioned above.

To this aim, write down the following TdynTcl code in a text file, 
and provide such a file as a simulation parameter.

General data ► Tcl data ► Use Tcl external script: Yes

proc TdynTcl_InitiateProblem { } {

 TdynTcl_Add_Mass_Matrix 1 [list 0.0 0.0 0.0] [list \

 8.6E+06 0 0 0 -349.16E+06 0 \

 0 8.6E+06 0 349.16E+06 0 0 \

 0 0 8.6E+06 0 0 0 \

 0 349.16E+06 0 14754.48E+06 0 0 \

 -349.16E+06 0 0 0 14754.48E+06 0 \

 0 0 0 0 0 361.4E+06 ]

 TdynTcl_Add_Mass_Matrix 1 [list 0.0 0.0 0.0] [list \

 0.7E+06 0 0 0 44.3E+06 0 \

 0 0.7E+06 0 -44.3E+06 0 6.6E+06 \

 0 0 0.7E+06 0 -6.6E+06 0 \

 0 -44.3E+06 0 3499E+06 0 0 \

 44.3E+06 0 -6.60E+06 0 3560E+06 0 \

 0 6.60E+06 0 -513.3E+06 0 101.2E+06 ]

 TdynTcl_Add_Damping_Matrix 1 [list 0.0 0.0 0.0] [list \

 0.04E+06 0 -0.01E+06 -0.25E+06 4.00E+06 0.08E+06 \

 0 0 0 -0.11E+06 -0.18E+06 -0.05E+06 \

 -0.01E+06 0 0 -0.04E+06 -0.92E+06 -0.33E+06 \

 0.27E+06 -0.1E+06 0 16.17E+06 50.30E+06 13.88E+06 \

 3.42E+06 0.06E+06 -1.00E+06 -23.92E+06 400.1E+06 59.01E+06 \

 0.05E+06 -0.02E+06 0.22E+06 11.08E+06 -52.60E+06 101.2E+06]

 TdynTcl_Add_Stiffness_Matrix 1 [list 0.0 0.0 0.0] [list \

 0 0 0 0.3E+06 0.2E+06 0 \

 0 0 0 -0.1E+06 0.3E+06 -0.07E+06 \

 0 0 0 -0.3E+06 -0.4E+06 0 \

 0 0 0 8.5E+06 -22.4E+06 59.7E+06 \

 0 0 0 26.8E+06 28.9E+06 -4.1E+06 \

 0 0 0 -1.2E+06 1.1E+06 -4.8E+06 ]

 TdynTcl_Add_Stiffness_Matrix 1 [list 0.0 0.0 0.0] [list \
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 0.247E+06 0 1.53E+06 0 -7.26E+06 0 \

 0 0.214E+06 0 6.27E+06 0 -0.511E+06 \

 1.53E+06 0 70.4E+06 0 -44.6E+06 0 \

 0 6.23E+06 0 15400E+06 0 -408E+06 \

 -6.94E+06 0 -31.8E+06 0 15400E+06 0 \

 0 0 0 -345E+06 0 94.7E+06 ]

 TdynTcl_Message "TdynTcl_DefineBodyData finished!!!" notice

}

In the code above, the following matrices are introduced in the 
given order:

- Mass matrix of the TLP platform.

- Mass matrix of the wind turbine.

- Damping matrix due to the wind 
turbine.

- Stiffness matrix of the wind turbine.

- Stiffness matrix due to the mooring 
system.

Note that all these matrices are reference to the origin of 
coordinates, and that output results will be referred to the (XG, 
YG, ZG) point specified in the SeaFEM data tree (being in this 
case also the origin of coordinates).

Finally, degrees of freedom of the floating structure must be 
activated as follows:

Body data ► group: name ► degrees of freedom

- Surge: activated

- Sway: restricted

- Heave: activated

- Roll: restricted

- Pitch: activated

- Yaw: restricted

The Body data section of the SeaFEM data tree also provides the 
option to apply external forces and moments to a given body. 
Use the following function for the Z-component of the external 
force, which is the force applied to the legs of the TLP structure 
tensioned in dynamic equilibrium.

Body data ► group: name ► External loads ► External force 
Z:

Mass*g-vol*density*g

4.3. General data
Once the geometry is ready, it is necessary to set up the 
properties and conditions that define the problem under 
consideration. First of all, select to perform a seakeeping 
analysis. For this, open the Start Data window and select the 
following options:

Data ► Start data

- Simulation dimension = 3D

- Seakeeping analysis environment = 
Waves

- Seakeeping analysis type = Seakeeping

- Units system = Int. system (SI) - N,m,Pa

- Geometry units = m

Seakeeping analyses undertaken using SeaFEM always consider 
that the fluid medium is sea water. Nevertheless, water density 
can be adjusted to match the actual fluid properties variation. 
For the present analysis, water density is taken as ρ = 1025 
kg/m3.

General data ► Water density ► Water density: 1025 kg/m3

Ensure that the results file is set to binary 2 option:

General data ► Results ► Results file: Binary 2

Since we are mainly interested in the RAOs results of the TLP 
structure, ensure that RAOs results output is activated:

General data ► Results ► Kinematics ► Raos: Yes

Note that RAOs results option becomes available only when the 
Wave spectrum type option is set to White noise within the 
Environment data section of the data tree.

Environment data ► Waves ► Wave spectrum type

4.4. Problem description

As mentioned in the Geometry definition section of the tutorial, a 
zone where no artificial dissipation is introduced is defined for 
numerical convinience. Such a no-dissipation region is usually 
centered at the body under analysis, and its outer boundary is 
specified by the beach parameter that must be inserted in the 
data tree. In this particular example, the beach parameter is set 
at a distance d= 30 m.

Open the Problem description section of the SeaFEM data tree 
and fill in the data as follows:

Problem description
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- Bathymetry: constant depth.

- Depth: 200.0 m.

- Waves absortion: Yes.

- X absorption reference: 0.0 m.

- Y absortion reference: 0.0 m.

- Absorption factor: 1.0

- Beach: 30.0 m.

- Sommerfeld radiation condition: Yes.

4.5. Environment data
In the Environment data section of the data tree the user defines 
the waves spectra properties that characterize the problem 
under analysis. Various predefined types of spectra are 
available, as for instance the monochromatic wave, white noise, 
pierson moskowitz, jonswap, and jonswap 2 spectra. In 
addition, custom wave spectra can be defined by the user as 
well as real spectra that can be directly read from text files. The 
actual parameters to be entered denpends on the type of 
spectra selected. In the present case a White noise spectra is 
used since we are mainly interested in the RAOs behavior of the 
TLP platform. To this aim, open the Environment data section of 
the data tree and setup the problem as follows:

Environment data ► Waves

 - Wave spectrum: White noise.

 - Amplitude: 1 m.

 - Direction: 0.0 deg.

 - Shortest period: 3 s.

 - Longest period: 20 s.

 - Number of waves periods: 40.

4.6. Time data
Next, analysis data concerning the time step and total 
simulation time must be introduced. For the present simulation 
these data reads as follows:

Problem description

- Simulation time:10000 s.

- Time step: 0.0 s.

- Output step: 0.5 s.

- Start time recording: 350 s.

- Initialization time: 300 s.

Remember that Time data parameters introduced by the user in 
problems concerning RAOs analysis are just for the sake of 
guidance. Actually, SeaFEM internally evaluates optimal values 
for both, the Simulation time and the time step based on Fourier 
analysis requirements.

4.7. Boundary conditions

Apart from Body data condition which is assgined to the entire 
boundary surface of the floating structure (see section ) three 
boundary conditions must be specified to set-up a well-defined 
problem; these are the free surface, the outlet and the bottom 
boundary conditions.

Boundary conditions ► Free surface

This boundary condition must be applied to the two surfaces 
located at the top of the computational domain.

Free surface boundary condition

Boundary conditions ► Outlet

Apply the outlet condition to the outer surface located around 
the computational domain.
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Outlet boundary condition

Boundary conditions ► Bottom

Apply this boundary condition to the two bottom surfaces of the 
computational domain.

Bottom boundary condition

4.8. Numerical data
The last configuration step of the analysis consists on specifying 
the numerical data. Processor unit and number of CPUs, solver 
and preconditioner, and many other paramters may be defined 
within this section of the data tree.

For the present simulation only the following numerical 
parameters need to be modified. 

Numerical data

- Processor unit: CPU+GPU (if available in 
the computer)

- Solver: Deflated conjugate gradient

- Preconditioner: Diagonal

- Solver tolerance: 1.0E-7

- Solver max. iterations: 1000

- Free surface stability factor: 0.5

- Damping factor: 0.0

- Dynamic solver max. iter.: 100

- Dynamic solver relaxation: 0.25

- Max. iter. time step: 20

- Tolerance: 1.0e-4

- Alpha B-N: -0.1

4.9. Mesh
Before starting the calculation the computational mesh must be 
generated. In order to do this it is necessary to assign diferent 
element sizes to points, lines, surfaces and volumes that 
constitute the computational domain. As usual, the mesh size is 
smaller around the body with the aim of having better 
discretization close to the analysis region. Further, the mesh 
size increases when approaching the absorption area.

To reproduce the computational mesh used for the present 
analysis, proceed to assign mesh sizes as shown in what follows.

Mesh ► Unstructured ► Assign sizes on surfaces and 
descends

Assign a size of about 1.0 m to the surfaces of the floating 
cylinder and to the analysis area free surface.

Once mesh element sizes are assigned, it has to be ensured 
that the meshing preferences are correctly chosen. To this aim, 
open the following option of the main menu and inspect some 
of the meshing preferences.

Utilities ► Preferences ► Meshing

- Unstructured mesher - Volume: Advancing 
front

- Automatic correct sizes: None

Then we can proceed to mesh generation by using the following 
option of the main menu and using the reported meshing 
settings.

Mesh ► Generate mesh

- Maximum element size: 40
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- Unstructured size transitions: 0.1

The mesh finally obtained must be similar to that shown in the 
figure bellow. It can be appreciated how the mesh is gradually 
refined when approaching the body surface.

Detail of the mesh close the TLP structure

Global view of the computational mesh

4.10. Results
After the meshing process the SeaFEM calculation can be 
started using the following option of the main menu.

Calculate ► Calculate

After finishing the calculation, load the postprocess module of 
SeaFEM

Potsprocess ► Start

For the sake of comparison against the NREL results, proceed to 
represent the pitch RAO results of SeaFEM.

View Results ► SeaFEM Graphs

- Select the RAOs.res results file

- Select Pitch results option.

The graph obtained should look similar to that shown in the 
figure bellow.

Pitch RAO results

RAOs results are reported in rad/m and are given as a function 
of time. 

The Filename.RAOs.res file can be editted externally to obtain for 
instance the displacement at the end of the TLP structure. To 
this aim, we must simply multiply the Pitch RAOs results by the 
corresponding gyration radius (i.e. 9.0 m). This can be useful to 
compare the SeaFEM obatined results with some other results. 
It has been done in this case to compare the results obtained 
with SeaFEM calculus against the results reported in the NREL 
study. The following graphs represent the pitch RAO obtained 
using SeaFEM and the pitch RAO reported in the NREL study.

SeaFEM pitch RAO graph.

NREL pitch RAO graph.

As we can see the results are very simillar in both studies, being 
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the max RAO obtained in SeaFEM about 0,184592, and in the 
NREL case about 0,19413, hence resulting in a difference of 
about 0,0095382 (i.e. 0.05%).
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5. ISSC TLP structure
The main object of this tutorial is to explain the basic use of the 
linear solver capabilities (frequency domain analysis) of SeaFEM 
by recreating the validation case of the ISSC TLP structure also 
used for validation purposes of the time domain module of 
SeaFEM. Also, by doing this, one can compare the results 
obtained with other programs.

To automatically load the model, ready to be meshed and run, 
simply left-click on the button below.

Load model

On the contrary, to build the model from scratch proceed as 
indicated in the following sections of this tutorial.

5.1. Problem description

First of all problem description data concerning the Linear 
module of SeaFEM is described. Note that the Linear module of 
SeaFEM deals with frequency domain analysis. 

Data tree ► Problem description

One of the main characteristics of the linear module of SeaFEM 
is the ease of use to prepare a new analysis. In this sense, only 
two parameters are required within the problem description 
section of the data tree:

-Bathymetry: Infinite depht. If Constant 
depth is chosen, then the depth has to be 
given.

-Depth: Only available if constant depth is 
chosen. If this is the case, then the depth 
should be inserted.

Problem Description data

5.2. Geometry definition

In this section of the tutorial we will briefly present the 
geometry used for the analysis. Such a geometry is exactly the 
same as that of the ISSC TLP structure used in the time domain 
validation case and can be found at the Compassis's webpage 

within the product's support section:

http://www.compassis.com/compass/en/Soporte

Once downloaded, the geometry can be inserted into a new 
SeaFEM project by importing the corresponding iges file. The 
following image shows the shape of the TLP structure:

ISSC TLP Structure geometry.

Once the geometry has been inserted, it is generally 
recommended to create a layer for each body. This is especially 
helpfull when various bodies are present in a single project. In 
this case, up to this point, just one layer must be present within 
the layers window 

Utilities ► Layers

Layers for the TLP Validation Case.

Finally, the normals of the geometry must be checked so that 
they point outwards of the body. If this is not done, the results 
will be incorrect.

5.3. General data
Once the geometry has been generated, it is time to set up the 
analysis. First of all, select to perform a frequency domain 
analysis. To this aim, open the Start Data window and select the 
following options:

Data ► Start data

- Simulation dimension = 3D

http://www.compassis.com/compass/en/Soporte
http://www.compassis.com/compass/en/Soporte
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- Analysis domain = Frequency domain

- Seakeeping analysis environment = 
Waves

- Type of analysis = Seakeeping

- Units system = Int. system (SI) - N,m,Pa

- Geometry units = m

The next step is to define the general data of the problem under 
consideration. To do so, go to the General data menu in the 
Data tree:

Data Tree ► General data

Seakeeping analyses undertaken using the linear frequency 
domain module allways consider that the fluid medium is sea 
water. Nevertheless, water density can be adjusted to match the 
actual fluid under consideration. For the present analysis, water 
density is taken as ρ = 1025 kg/m3.

General data ► Water density ► Water density: 1025 kg/m3

Ensure that the results file is set to binary 2 option:

General data ► Results ► Results file: Binary 2

Frequency domain results can be stored in several different 
formats; Default (which is the same as binary2), binary1, ASCII 
or Nemoh formats. If Nemoh is chosen, all results files will be 
stored using the native Nemoh format anb placed under the 
Nemoh_output folder. For the present validation case, use 
default or binary2 options which correspond to the native 
output format of SeaFEM.

General Data.

As a final remark, note that most of the general simulation 
parameters can also be set from the Start Data window which 
prompts when the program is started, or when clicking the 
following option within the menu bar.

Data ► Start data

SeaBEM Start Data window

5.4. Environment data
In the Environment data section of the data tree the user defines 
the wave properties that characterize the problem under 
consideration. For the present case, the following values must 
be introduced to setup the problem:

Environment data ► Waves

- Shortest period: 8 s.

- Longest period: 15 s.

- Number of wave periods: 10

- Lower heading: 0 deg

- Upper heading: 90 deg

- Number of wave headings: 5

- Speed: 0 m/s

- Speed direction: 0 deg

5.5. Body data

In this section the body boundary conditions are defined:

Data tree ► Body data

The main body properties are:

Mass: 0.0 Kg. This way the mass is calculated using 
the displacement caused by the body.
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The center of gravity: (XG=0m, YG=0m, ZG=3m)

The radii of gyration has the following values:

Radii of gyration Matrix

For this case, the free degrees of freedom are:

Body Data configuration menu.

5.6. Mesh
Finally, before beginning the calculation, the mesh has to be 
defined. This case can be calculated with a relatively simple 
mesh without having to define any mesh data. Frequency 
domain calculations require a mesh of quadrilateral elements. 
Nevertheless, there is no need to change the element type () 
within the mesh properties menu since SeaFEM automatically 
manages these mesh requirements. Without further ado, the 
following data is used:

Mesh ► Element type

Open the mesh generation menu found under the 
"mesh" main menu: . The following window will 
appear:

Mesh ► Generate mesh

Mesh generation menu.

As it can be observed, the 
element size will be 4, with a 
transition size of 0.2.

After creating the mesh, the number of nodes 
should be aroung 1187, and the number of 
elements around 1167.

5.7. Results
This final section shows some of the results ascertained after 
executing the frequency domain solver.

After meshing the body, we can proceed to execute the solver 
for calculation. This is done by executing the following menu 
sequence:

Calculate ► Calculate

or by pressing the icon shown below which is located within the 
SeaFEM toolbar:

Once the calculation has started, information on how it's doing 
can be found by going to the following menu's option:

Calculate ► View process info...

or by pressing the following icon in the toolbar:

If the exectution finishes ok, a message will be prompted that 
will also ask if you wish to go to the postprocessor. As the 
default type of results was chosen, press postprocess. Another 
way to postprocess is by going to the following menu's option:

Postprocess ► Start

or by pressing the following icon:
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If the type of results option chosen was not default or Binary2, 
the traditional post has to be used. To do this use:

Postprocess ► Traditional post

To see graph results when using the default (binary2) 
postprocess format, use the following option of the postprocess 
menu:

Postprocess ► SeaFEM graphs

On the contrary, if using the traditional post, go to:

View Results ► SeaFEM Graphs

With this, the following window should pop up:

Seakeeping graphs.

For the sake of comparison the results concerning a heading 
direction about 22.5 degrees will be used. Hence, select 
"A_Roll/A_wave" within the second heading results box. By 
clicking on draw, the following graph is obtained:

RAO of roll motion for a wave direction of 22.5 degrees using SEABEM.

For the sake of comparison, the output of SeaFEM is 

postprocessed and plotted together with the results of WAMIT. 
The corresponding graphs are shown below. It must be taken 
into account that WAMIT provides RAOs results in non-
dimensional form for both, translation and rotational degrees of 
freedom. For the latter, this is achieved by multiplying RAOs 
results by a characteristic length provided as an input of the 
model under analysis. In this particular case, such a 
characteristic length is half the separation between the legs of 
the TLP structure, and is about L = 43.125 m. Hence, for propper 
comparison, SeaFEM results concerning RAOs rotational 
degrees of freedom are also multiplied by the same 
characteristic length.
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6. Multibody analysis of a Pelamis device

The next tutorial illustrates the use of SeaFEM's multibody 
capabilities for the analysis of complex devices involving the 
mechanical interaction of various moving parts. To this aim, the 
analysis of a device of the Pelamis type is undertaken. The 
Pelamis is a design conceived for extracting energy from waves. 
It consists of a set of bodies with a snake shape connected by 
mechanical joints, whose actual shape is rearranged due to the 
action of waves. Energy can be extracted from the relative 
movement accross consecutive segments of the device.

In this tutorial, a simplified version of the Pelamis, consisting of 
just two articulated segments, is modelled under the action of 
irregular sea waves.

6.1. Geometry definition and body data

In this tutorial, geometry creation is not described in detail. 
Actually, the geometry of the Pelamis device is simple enough 
as to be constructed using the CAD capabilities provided by the 
SeaFEM pre-processor and explained in detail in previous 
tutorials.

The Pelamis considered here consists of two circular cylinders 
connected by a ball joint with an additional restriction that 
prevents any relative rotation between the two segments along 
their common longitudinal axis. An energy extracting system is 
used to extract energy from the relative pitch velocity between 
the two cylinders. Such and energy extracting system acts in 
turn as pitch damper. The main characteristics of each Pelamis 
segment are summarized in the table below.

Length 34.0 m.
Beam 5.5 m.
Draft 3.404 m.
Distance between segments 1.5 m.
XG (from stern side) 17.0 m.
YG 0.0 m.
ZG -1.0 m.
Radii of inertia Rxx 2.4 m.
Radii of inertia Ryy = Rzz 12.3 m.

The geometry of the submerged part of the Pelamis, and the 
corresponding computational domain are shown in the figure 
below.

Geometry of the sumerged part of the Pelamis device considered in the present analysis
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Computational domain used for the analysis of the Pelamis device. Domain's depth is taken 
to be h = 100.0 m. A near field region is considered with a diameter D = 400 m.

Body properties must be especified separatelly for each 
segment of the Pelamis by applying a Body condition to each 
one of the parts. Body properties should read as follows:

Body data ► group:Segment1 ► Body properties

- Mass: vol(1)*density

- XG:-17.75 m

- YG:0.0 m

- ZG:-1.0 m

- Radii of gyration Rxx: 2.4 m

- Radii of gyration Ryy = Rzz: 12.3

Body data ► group:Segment1 ► Degrees of freedom

- Surge: Yes

- Sway: Yes

- Heave: Yes

- Roll: Yes

- Pitch: Yes

- Yaw: Yes

Body data ► group:Segment2 ► Body properties

- Mass: vol(2)*density

- XG: 17.75 m

- YG: 0.0 m

- ZG:-1.0 m

- Radii of gyration Rxx: 2.4 m

- Radii of gyration Ryy = Rzz: 12.3

Body data ► group:Segment2 ► Degrees of freedom

- Surge: Yes

- Sway: Yes

- Heave: Yes

- Roll: Yes

- Pitch: Yes

- Yaw: Yes

Real PTO models of actual Pelamis devices are quite complex 
and detailed information is usually not publicly available. Hence, 
in this tutorial a simplified PTO model is going to be used. In 
this sense, the PTO is assumed to work as a pitch damper, 
where the reaction of the dampers produces a pitch moment in 
the opposite direction of the relative pitch velocity, and whose 
magnitude is proportional to the relative velocity. The 
mathematical model describing this PTO system is:

My
(1 ) = - KPTO (ωy

(1 ) - ωy
(2 ) )

My
(2 ) = - KPTO (ωy

(2 ) - ωy
(1 ) )

P = KPTO (ωy
(2 ) - ωy

(1 ) )2

where My
(i )andωy

(i )represent the pitch moment and angular 
velocity for segment (i), KPTOis a constant value depending on 
the PTO design, and P  is the instantaneous extracted power. In 
the present tutorial KPTO value was assumed to be 5.0E7 
N·m/rad/s

The moments exherted by the PTO system over each one of the 
Pelamis parts can be especified in the form of an external 
moment within the Body data definition of the corresponding 
Body group.

Body data ► group:Segment1 ► External loads
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- External moment Y: -5.0E7*(wy(1)-wy(2))

Body data ► group:Segment2 ► External loads

- External moment Y: -5.0E7*(wy(2)-wy(1))

6.2. General data
In the present tutorial, we are interested on the seakeeping 
analysis of the Pelamis device. Hence, the floating bodies must 
be subjected to the action of an irregular waves spectrum. In 
particular, a Jonswap's type spectrum is considered without 
currents. General data defining the problem can be summarized 
as follows. Parameters not mentioned here may keep its default 
value.

General data ► Water density

- Water density: 1025 kg/m3

General data ► Problem setup ► Environment

- Waves: 1

- Current: 0

General data ► Problem setup ► Type of analysis

- Seakeeping: 1

- Turning circle: 0

- Towing: 0

General data ► Results ► Kinematics

- Movements: Yes

- Velocities: Yes

- Accelerations: Yes

- Raos: No

General data ► Results ► User defined ► Custom output 1

- Active: Yes

- Name: My_PTO

- Expression: -5.0E7*(wy(1)-wy(2))

General data ► Results ► User defined ► Custom output 2

- Active: Yes

- Name: Instantaneous power

- Expression: 5.0E7*(wy(2)-wy(1))^2

Note the usage of two custom outputs defined by the user that 
are intended to keep track of the moment acting on each 
segment of the Pelamis due to the damping action of the PTO 
and to record the instantaneous power extracted also by the 
idealized PTO system under consideration.

6.3. Problem description

As usual, a zone where no artificial dissipation occurs is defined 
for numerical convinience. Such a none-dissipative region is 
usually centered at the body under analysis, and its outer 
boundary is specified by the beach parameter that must be 
inserted in the data tree. In this particular example, the beach 
parameter is set up so that the none-dissipative region 
coincides with the region with finner mesh resolution created 
around the body (near field region). Nevertheless, such a 
coincidence is in general not mandatory.

Open the Problem description container in the SeaFEM data tree 
and fill in the corresponding data as follows:

Problem description

- Bathymetry: Constant depth

- Depth: 100 m

- Wave absorption: Yes

- X absortion reference: 0 m

- Y absortion reference: 0 m

- Absorption factor: 1.0

- Beach: 200 m
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- Sommerfeld radiation condition: Yes

6.4. Environment data
The wave environment under consideration corresponds to an 
irregular sea modelled with a Jonswap spectrum with a mean 
wave period of 11.0 s., a significant wave height of 2.5 m., and a 
wave spreading angle of 30.0 degrees. The mean direction of 
propagation is along the x axis, wich is alligned with the 
longitudinal direction of the device. A total number of 55 
monochromatic waves have been used to reproduce the 
irregular sea under consideration. All actual properties of the 
spectrum under consideration are summarized as follows 
(parameters not reported in the following list should take their 
default values).

Environment data ► Waves

- Wave spectrum type: Jonswap

- Mean wave period: 11 s

- Significant wave height: 2.5 m

- Shortest period: 4 s

- Longest period: 22 s

- Number of waves periods: 11

- Mean wave heading: 0 deg

- Spreading angle: 30 deg

- Number of waves headings: 5

6.5. Time data
Apart from wave environment, analysis data concerning the 
time step and total simulation time must be introduced. For the 
present simulation these data reads as follows:

Time data

- Simulation time:1000 s

- Time step:0.0 s

- Output step: 0.5

- Start time recording:10 s

- Initialization time:10 s

When time step is set to 0.0, it is actually evaluated internally by 
SeaFEM based on a stability criteria related to the Free surface 
stability factor entered in the Numerical data section of the data 
tree. A simulation time about 1000 s may be used for the sake of 
computation time economy. Nevertheless, longer time series 
are usually required, specially when the model under 
consideration is intented for the assessment of wave power 
extraction. In this sense, it can be useful to keep track of the 
time evolution of the mean generated power since it provides a 
good measure of the convergence of the simulation results (see 
the results section of this tutorial for further details).

6.6. Mooring system

The mooring system used to avoid drift effects on the device 
consists of three single-segment catenary lines, all of them 
connected to the front of the hull of the first segment of the 
Pelamis. The three lines then spread towards the sea bottom 
with a spreading angle of 120 degrees between the lines. The 
three catenary lines are identical and their main characteristics 
are summarized in the table below.

Length 267.4 m.
Cross-section area 7.85E-3 m2

Effective linear density 525.64 kg/m
Young modulus 210 GPa

The graphic user interface of SeaFEM provides tools to ease the 
setup of mooring systems, from very simple moorage lines like 
those used in the present tutorial to very complex mooring 
systems consisting of several multi-segmented lines with 
additional buoys and weights designed for fine station-keeping 
control.

Here, we will be briefly present the various steps necessary to 
define the mooring lines used to connect the Pelamis to the sea 
bottom. 

 To define a new mooring system in SeaFEM, double-click on 
the  option of the data tree. Note that to define mooring 
data at least one body must be already defined. If not, the 
following warning message would appear.

Mooring data

 The first time mooring data definition is invoked, the 
following message will appear asking for confirmation.
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 Once accepted, mooring capabilities will become active, the 
first mooring line containing a single element will be 
automatically created and the Mooring element definition 
window will be opened as shown in the figure below. 
Within this window, the user must specify the mooring line 
segment properties (as reported in the summary table at 
the beginning of this section) and the corresponding 
connection points.

 To create a connection point, left-click the Edit link icon next 
to the End A/B window entries. When one or more 
connection points have been already defined, they will be 
available in the drop down list allowing their direct 
selection. The new connection point creation window looks 
like those in the following images, where data definning 
the first fairlead and anchor points have been entered 
respectively. For further details on all the options available 
for the definition of different types of conection points see 
the SeaFEM's users manual.

Fairlead point definition's window (point where the mooring segment is directly attached to 
the body)

Anchor point definition's window (point where the mooring segment is fixed to the seabed)

 After definition of the two connections points of the 
mooring segment, and after introducing all the properties 
that define the corresponding mooring element, the 
definition's windows should look like this:
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 New mooring lines can be defined from scratch, or may be 
created by copying and editing an already existing line. For 
the latter option, just right-click on the existing mooring 
line group and select Copy option. Next, the name of the 
new mooring line can be edited as well as the connection 
points and mooring element properties.

6.7. Multibody analysis definition

To end with the setup of a multibodies analysis, it is necessary 
to define the links between bodies that actually define the 
required mechanical constraints. As in the case of the mooring 
system, SeaFEM provides GUI tools to ease the definition of 
complex multibody systems. In this section it will be explained 
how to define a simple connection between the two cylindrical 
segments of the Pelamis.

 To define a new body joint in SeaFEM, double-click on the  
option of the data tree. Note that to define a body joint at 
least one body must be already defined (it is possible to 
define mechanical constraints involving only a single body 
using some of the body joint options, all of them based on 
the same langrange multipliers formulation). If not, the 
following warning message would appear.

Body joints

 The first time body joints option is invoked, the following 
message will appear asking for confirmation.

 Once accepted, body joint capabilities will become active, a 
first set of body joints containing a single body joint will be 
automatically created and the Body joint definition window 
will be opened as shown in the figure below. Within this 
window, the user must specify the type of connection and 
the bodies involved in the definition of the current joint. 
Depending on the type of body joint selected different 
parameters may be required to finallize the set up of the 
corresponding mechanical constraints.

 In the following figures the definitions of a Ball joint and a 
simple Rotation link between the two cylindrical segments 
of the Pelamis device are shown.

Definition of a Ball joint between segments 1 and 2 of the Pelamis device under analysis in 
the present tutorial

Definition of a simple Rotation link that enforces the Roll movement to be the same in both 
segments of the Pelamis

6.8. Boundary conditions

As usual, several boundary conditions must be applied to 
finalize the set up of the SeaFEM analysis. In addition to the 
Body conditions described in detail in section Geometry 
definition and body data, the following boundary conditions 
must be applied.

First, a Free surface condition must be applied to those surfaces 
located at z=0 

Boundary conditions ► Free surface

Finally, an Outlet boundary condition must be applied to the 
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outer boundary of the computational domain. If a Sommerfeld 
radiation condition is to be applied, the outer surface should be 
of circular shape with center at the origin of coordinates.

Boundary conditions ► Outlet

6.9. Mesh
The computational domain considered for the present analysis 
has 100 m. depth. A mesh size of 0.5 m. has been used for the 
device and its surroundings. A mesh size of about 5.0 m. is used 
in the near field region. A maximum mesh size about 50 m. and 
an unstructured mesh size transition of 0.3 is used for mesh 
generation as shown below. The damping zone is located 
starting at 200 m. away from the device. The resulting mesh 
consists of 20,436 nodes and 105,046 linear tetrahedra.

Maximum element size and unstructured mesh size transition used during the generation 
of the finite element mesh for the analysis of the Pelamis device under consideration in the 

present tutorial

Element sizes explicitly assigned to various geometrical entities of the bodies and the 
computational domain for fine tunning of the generated mesh.

Isometric global view of the finite element mesh used in the simulation of the seakeeping 
behavior of a Pelamis (multibody) device

6.10. Results
This final section shows some of the results obtained after 
executing the time domain solver.

After meshing the model we can proceed to execute the solver 
for calculation. This is done by executing the following menu 
sequence:

Calculate ► Calculate

or by pressing the icon shown below which is located within the 
SeaFEM toolbar:

Once the calculation has started, information on how it's doing 
can be found by going to the following menu's option:

Calculate ► View process info...

or by pressing the following icon in the toolbar:

If the exectution finishes ok, a message will be prompted that 
will also ask if you wish to go to the postprocessor. Postprocess 
can be also accesssed at any time by using the main menu 
option:

Postprocess ► Start

or by pressing the following icon:

When using the default (binary2) postprocess format, time 
evolution graphical results can be visualized by using the 
following option of the main postprocess menu:

Postprocess ► SeaFEM graphs

On the contrary, if using the traditional post, go to:

View Results ► SeaFEM Graphs

Pitch moment on body 1 due to the action of the PTO and the 
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instantaneous extracted power are shown in the following 
figures as they appear in the graphical results window of the 
SeaFEM postprocess.

Pitch moment on body 1 (N·m)

Instantaneous extracted power (W)
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As explained in the Time data section of this tutorial, large time 
series may be simulated for an accurate assessment of the wave 
power extraction. And it mat be a good practice to plot the time 
evolution of the mean generated power since it will usually 
provide a good mesaure of the simulation's convergence. To 
this aim, the instantaneous power data recorded in the custom 
output results file can be edited and operated to obtain the 
mean generated power. Pitch moment, instantaneous power 
and mean power are plotted together in the following graph.

Time evolution of some quantities that are of interest in the analysis of the Pelamis device 
analized in the present tutorial. a) Pitch moment acting on segment 1 of the Pelamis due to 

the action of the PTO. b) Instantaneous power extracted from waves by means of the 
ideallized PTO considered in this tutorial. c) Time evolution of the mean power extracted 

from waves. It can be observed that after 1500 s. the mean power remains almost constant 
indicating that the simulation has converged for the wave spectrum under consideration

7. Analysis of a floating OWC device

The next tutorial illustrates the use of SeaFEM capabilities for 
the analysis of oscillating water column (OWC) devices. OWCs 
are a particular type of wave energy converter (WEC) designed 
to harness the energy from a water column that oscillates due 
to the action of waves inside of a pressurized chamber. Waves 
actually force the water column to act like a piston forcing the 
air to flow out and back into the chamber. This causes a 
continuos stream flowing through a bidirectional turbine that 
finally converts pneumatic power into electricity.

In this tutorial, a simplified version of a floating OWC device is 
considered. It consists of three tied chambers with squared-
shape cross-section. Emphasis is on explaining how to set up 
pressurized free surface (PFS) boundary conditions, and how to 
take into account in the dynamics of the floating body the 
forces acting on the device due to the internal pressure of the 
chambers.

7.1. Geometry definition and body data

In this tutorial, geometry creation is not described in detail 
since it is simple enough as to be constructed using the CAD 
capabilities provided by the SeaFEM pre-processor explained in 
previous tutorials.

The OWC design considered in this tutorial consists on a scale 
model of a device with three square-shaped columns opened to 

the sea water at their bottom. The main characteristics of the 
device are summarized in the following table.

Total length 1.408 m.
Draft 0.1995 m.
XG 0.0 m.
YG 0.0 m.
ZG -0.052 m.
Radii of inertia Rxx 0.150 m.
Radii of inertia Ryy 0.410 m.
Radii of inertia Rzz 0.546 m.
Separation between chambers 0.2 m.
Inner chamber cross section 0.0576 m2

The geometry of the submerged part of the OWC device, and 
the corresponding computational domain are shown in the 
figure below.

Geometry of the submerged part of the floating OWC device. It can be observed how the 
three independent chambers are joined by rigid arms so that the device as a whole behaves 

as a rigid body

Computational domain used for the analysis of the OWC device. Domain's depth is taken to 
be h = 0.8 m. A near field region is considered with a diameter D = 44 m.

Since the three chambers are rigidly connected, body properties 
can be especified considering the whole device as being a single 
rigid body. To this aim, just one Body condition is applied to all 
surfaces defining the geometry of the OWC device (inner and 
outer walls of the three chambers and their joining arms). Body 
properties should read as follows:

Body data ► group:Body data Auto1 ► Body properties

- Mass: vol*density

- XG: 0.0 m
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- YG: 0.0 m

- ZG: -0.052 m

- Radii of gyration Rxx: 0.150 m

- Radii of gyration Ryy: 0.41 m

- Radii of gyration Rzz: 0.546 m

Body data ► group:Segment1 ► Degrees of freedom

- Surge: Yes

- Sway: Yes

- Heave: Yes

- Roll: Yes

- Pitch: Yes

- Yaw: Yes

7.2. General data
As in the previous tutorial, we are interested in the seakeeping 
behavior of the floating structure under the action of an 
irregular sea state. Hence, the floating body is going to be 
subjected to the action of an Jonswap spectrum. General data 
defining the problem can be summarized as follows. 
Parameters not mentioned here may keep its default value.

General data ► Water density

- Water density: 1025 kg/m3

General data ► Problem setup ► Environment

- Waves: 1

- Current: 0

General data ► Problem setup ► Type of analysis

- Seakeeping: 1

- Turning circle: 0

- Towing: 0

General data ► Results ► Kinematics

- Movements: Yes

- Velocities: Yes

- Accelerations: Yes

- Raos: No

7.3. Problem description

As usual, a zone where no artificial dissipation occurs is defined 
for numerical convinience. Such a none-dissipative region is 
usually centered at the body under analysis, and its outer 
boundary is specified by the beach parameter that must be 
inserted in the data tree.

Open the Problem description container in the SeaFEM data tree 
and fill in the corresponding data as follows:

Problem description

- Bathymetry: Constant depth

- Depth: 0.8 m

- Wave absorption: Yes

- X absortion reference: 0 m

- Y absortion reference: 0 m

- Absorption factor: 1.0

- Beach: 3 m

- Sommerfeld radiation condition: Yes

7.4. Environment data
The wave environment under consideration is scalled in 
accordance to the geometry of the model under consideration. 
It actually corresponds to an irregular wave state described by a 
unidirectional Jonswap spectrum with a mean wave period of 
1.14 s. and a significant wave height of 0.028 m. The mean 
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direction of propagation is at 45 degrees about the x axis, 
misaligened with respect to the longitudinal axis of the floating 
structure. A total number of 25 monochromatic waves have 
been used to reproduce the irregular sea under consideration. 
All actual properties of the spectrum under consideration are 
summarized as follows (parameters not reported in the 
following list should take their default values).

Environment data ► Waves

- Wave spectrum type: Jonswap

- Mean wave period: 1.14 s

- Significant wave height: 0.028 m

- Shortest period: 0.52 s

- Longest period: 2.508 s

- Number of waves periods: 25

- Mean wave heading: 45 deg

- Spreading angle: 0 deg

- Number of waves headings: 1

7.5. Time data
Apart from wave environment, analysis data concerning the 
time step and total simulation time must be introduced. For the 
present simulation these data reads as follows:

Time data

- Simulation time: 150 s

- Time step: 0.0 s

- Output step: 0.5

- Start time recording: 0 s

- Initialization time: 10 s

When time step is set to 0.0, it is actually evaluated internally by 
SeaFEM based on a stability criteria related to the Free surface 
stability factor entered in the Numerical data section of the data 
tree.

7.6. Mooring system

The mooring system used to avoid drift effects on the device 
consists of four single-segment catenary lines, each one 
anchored to one bottom corner of the structure. The four lines 
then spread towards the sea bottom. The four catenary lines 
are identical and their main characteristics are summarized in 
the table below.

Mooring element type Catenary
Length 3.75 m.
Cross-section area 5.6332E-6 m2

Effective linear weight 0.378544 N/m
Young modulus 210 GPa

SeaFEM provides a simple tool that may help on the design of 
very simple mooring lines like those used in the present 
analysis. To acces this tool, simply resort to the following main 
menu option:

Geometry ► Create ► Catenary NURBS...

This tool consists of a window form where the user must enter 
all the prameters that define the mooring line (i.e. end points Xi 
and Xe, efective linear weight W, cross-section area A, Young's 
modulus E and length L). Currently, only elastic catenary lines 
can be modeled using this tool, but two types of seabed 
interaction can be taken into account. The first one is actually a 
"no seabed" option so that the resulting catenary will freely 
slack between the two specified end point. The second type of 
seabed interaction corresponds to the "sandy bed" option and 
the resulting catenary will not slack but will partially lie at the 
ground level given by the second end point.

Catenary creation window. This tool is provided in SeaFEM to help users define simple 
mooring lines based on elastic catenaries. It works by providing the properties of the 

mooring segment whose elastic catenary equilibrium solution is further plotted for the ease 
of visualization

Once all the parameters are introduced and the 'Create' button 
is invoked, the program solves the elastic catenary problem to 
find the equilibrium configuration of the mooring line. This 
configuration is finally ploted in the graphic user interface for 
visual inspection. This tool is useful as far as it allows to visualize 
the initial configuration of simple mooring systems (i.e. those 
composed of single-segment lines) thus providing the 
opportunity to detect obvious design errors (especially those 
errors related with the coordinates of the fairled and anchor 
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points) before introducing all mooring information in the data 
tree. The geometry of the mooring lines that is ploted in the GUI 
also eases the definition of the mooring geometry in teh data 
tree since the end points of each mooring element can be 
selected interactively. Note: it is recommended to isolate in an 
independent layer the mooring geometry generated by the 
'Catenary NURBS' option. This further allows to freeze this 
auxiliar layer when meshing the model. 

Initial equilibrium configuration of the 4-lines mooring system used for the present analysis 
of the OWC device

7.7. Boundary conditions

As usual, several boundary conditions must be applied to 
finalize the set up of the SeaFEM analysis. In addition to the 
Body conditions described in detail in section Geometry 
definition and body data, the following boundary conditions 
must be applied.

First, a Free surface condition must be applied to those surfaces 
located at z=0.

Boundary conditions ► Free surface

It is important to note that the free surface boundary condition 
must include also the free surface patches located inside of the 
chambers, where 'Pressurized free surface' conditions will be 
also applied later.

An Outlet boundary condition must be applied to the outer 
boundary of the computational domain. If a Sommerfeld 
radiation condition is to be applied, the outer surface should be 
of circular shape with center at the origin of coordinates.

Boundary conditions ► Outlet

Finally, 'Pressurized free surface' boundary conditions must be 
applied on the top of each oscillating water column. An 
independent condition must be applied to each column as 
shown in the figure below.

Boundary conditions ► P Free surface

Pressurized free surface boundary conditions applied to the top of the oscillating water 
columns. Note that a 'P Free surface' conditions is applied separately to each one of the 

columns

'P Free surface' boundary condition applies to each node of its 
corresponding surface patch a pressure value given by:

P = (Paver + Pvar ( t ) ) · Pdist (x,y)

where P  is the pressure to be applied, Pave is an average 
pressure value which is constant in time and uniform in space, 
Pvar ( t )  is a pressure variable in time but uniform in space, and 
Pdist (x,y)  is a distribution function constant in time and vairbale 
in the x-y plane. The pressure enforced by the user through this 
condition may account for any conceivable effect. Nevertheless, 
the basic expression in the case of an OWC device will be of the 
form:

P = C · flux * abs(flux)

where C  is a constant that characterizes the turbine to which 
the chamber is connected, and flux is an internal variable 
calculated by SeaFEM that corresponds to the air flux induced 
by the oscillating water column. For the present analysis the 
constant C is equal to 14.7E6, the average pressure is zero and 
the pressure distribution function takes a uniform value equal 
to 1.0. The next two figures show how to fill the forms that 
define the 'P Free surface' boundary condition.

Editor window for the P Free Surface boundary condition

Function editor window showing the expression of the pressure variation function enforce 
on the top free surface of the first oscillating water column. Equivalent expressions must be 

used for the rest of the chambers just changid the chamber identification index

7.8. Body external loads

In addition to the environment wave loads, the dynamic 
behavior of a floating OWC device is also influenced by the 
forces and moments exherted over the structure due to the 
overpressure that exists inside of the column chambers. At each 
time step, SeaFEM evaluates a first order approximation for 
such forces and moments. These magnitudes are internally 
accessible during the calculation and can be applied as external 
forces on the structure to take into account their influence on 
the dynamics of the floating body. In order to solve the dynamic 
problem, all external forces and moments must be referred to 
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the center of gravity of the body. Hence, the total external force 
and moment acting on the floating structure are given as a first 
approximation by the following expressions:

F = ∑
i
fi

M = ∑
i
mi + ∑

i
ri xfi

where i = 1,...,n refers to each one of the existing chambers and 
ri  refers to the position vector from the center of gravity to the 
center of the corresponding column's free surface. Hence, in 
the present case the components of the external forces and 
moments acting on the OWC device read as follows:

Fx = f1x + f2x + f3x

Fy = f1y + f2y + f3y

Fz = f1z + f2z + f3z

Mx = M1x + M2x + M3x + y1 · f1z - z1 · f1y + y2 · f2z - z2 · f2y +
y3 · f3z - z3 · f3y

My = M1y + M2y + M3y + z1 · f1x - x1 · f1z + z2 · f2x - x2 · f2z +
z3 · f3x - x3 · f3z

Mz = M1z + M2z + M3z + x1 · f1y - y1 · f1x + x2 · f2y - y2 · f2x +
x3 · f3y - y3 · f3x

Using the SeaFEM's syntax and the actual values of ri  for each 
column, the expressions to be entered in the 'External loads' 
fields of the 'Body data' section in the data tree are as follows:

Fx = Fx_Pfs(1 ) + Fx_Pfs(2 ) + Fx_Pfs(3 )

Fy = Fy_Pfs(1 ) + Fy_Pfs(2 ) + Fy_Pfs(3 )

Fz = Fz_Pfs(1 ) + Fz_Pfs(2 ) + Fz_Pfs(3 )

Mx = Mx_Pfs(1 ) + Mx_Pfs(2 ) + Mx_Pfs(3 ) - 0.052 *
Fy_Pfs(1 ) - 0.052 * Fy_Pfs(2 ) - 0.052 * Fy_Pfs(3 )

My = My_Pfs(1 ) + My_Pfs(2 ) + My_Pfs(3 ) + 0.052 *
Fx_Pfs(1 ) + 0.536 * Fz_Pfs(1 ) + 0.052 * Fx_Pfs(2 ) + 0.052 *

Fx_Pfs(3 ) - 0.536 * Fz_Pfs(3 )

Mz = Mz_Pfs(1 ) + Mz_Pfs(2 ) + Mz_Pfs(3 ) - 0.536 *
Fy_Pfs(1 ) + 0.536 * Fy_Pfs(3 )

7.9. Mesh
The computational domain for the present analysis corresponds 
to a control volume scaled in accordance to the model of the 
OWC device. Element sizes have been applied to the body of the 
OWC device and to the near field region in order to control the 
resolution of the finite element mesh which finally consists of 
51,067 nodes and 281,466 linear tetrahedra.

Maximum element size and unstructured mesh size transition used during the generation 
of the finite element mesh for the analysis of the floating OWC device under consideration 

in the present tutorial

Element sizes assigned to the body of the OWC device and to the perimeter of the near field 
region

Detailed view of the finite element mesh used in the simulation of the seakeeping behavior 
of an OWC floating device

7.10. Results
This final section shows some of the results obtained after 
executing the time domain solver.

After meshing the model we can proceed to execute the solver 
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for calculation. This is done by executing the following menu 
sequence:

Calculate ► Calculate

or by pressing the icon shown below which is located within the 
SeaFEM toolbar:

Once the calculation has started, information on how it's doing 
can be found by going to the following menu's option:

Calculate ► View process info...

or by pressing the following icon in the toolbar:

If the exectution finishes ok, a message will be prompted that 
will also ask if you wish to go to the postprocessor. Postprocess 
can be also accesssed at any time by using the main menu 
option:

Postprocess ► Start

or by pressing the following icon:

When using the default (binary2) postprocess format, time 
evolution graphical results can be visualized by using the 
following option of the main postprocess menu:

Postprocess ► SeaFEM graphs

On the contrary, if using the traditional post, go to:

View Results ► SeaFEM Graphs

In the following figure, it can be observed the total wave 
elevation inside of each one of the three chambers of the OWC 
device as well as in the near field region around the floating 
structure.

Total wave elevation in the region close to the OWC floating structure and inside of the 
three chambers of the device.

Pitch rotation of the floating OWC device is compared in two 
distinct models in the following graph. In the first case, external 
forces due to the pressure inside of the chambers are not taken 
into account. In the second case, these forces are added to the 
dynamics of the floating structure to assess their influence on 
the global movement of the device.

Pitch rotation of the floating OWC device. In Case 1 the forces due to the internal pressure 
of the chambers is not taken into account. In Case 2 theses external forces are added to the 
dynamics of the device to assess their actual influence on the global behavior of the floating 

structure.


